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Lesson objectives
 To learn how to work with the registers for QuickBooks bank accounts

 To demonstrate how to open a register

 To learn the features common to all registers

 To learn when and how to make entries directly in the register

 To demonstrate how to reconcile a QuickBooks bank account

Supporting materials
 Handout 3: Registers associated with QuickBooks windows

 PowerPoint file: Lesson 4

 Video tutorial: Overview of QuickBooks accounts

Instructor preparation
 Review this lesson, including examples, to make sure you’re familiar with the 

material.

 Ensure that all students have a copy of qblesson.qbb on their computer’s hard disk.

 Have Handout 3 ready for distribution.

To start this lesson
Before you perform the following steps, make sure you have installed the exercise file 
(qblesson.qbb) on your hard disk. See “Installing the exercise file” in the Introduction 
to this guide if you haven’t installed it.

The following steps restore the exercise file to its original state so that the data in the file 
matches what you see on the screen as you proceed through each lesson.

To restore the exercise file (qblesson.qbb):
1 From the File menu in QuickBooks, choose Open or Restore Company.

QuickBooks displays the Open Company: Type window.

2 Select “Restore a backup copy (.QBB) and click Next.

3 In the Restore Backup: Method window, select Local Backup and click Next.

4 In the Open window, navigate to your c:\QBtrain directory.

5 Select the qblesson.qbb file, and then click Open.

6 In the “Restore Backup: To Location” window, click Next.

7 Navigate to your c:\QBtrain directory.
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8 In the File name field of the Restore To window, type lesson 4 and then click Save.

9 Click OK when you see the message that the file has been successfully restored.

Writing a QuickBooks check
You can enter checks directly into the check register by using the QuickBooks Write 
Checks window. When you enter a check at the Write Checks window, you can see the 
address information and easily allocate the check between multiple accounts.

Suppose that you need to write a check to pay Rock Castle Construction’s telephone bill.

To write a check:
1 In the Banking area of the Home page, click Write Checks.

QuickBooks displays the Write Checks window.

The Bank Account field shows the account from which you are writing this check. 
QuickBooks displays the current date in the Date field. (The sample data is set to 
display December 15, 2007 as the current date.) You can change either of these 
values if you wish, but they are fine for our example.

2 Select the “To be printed” checkbox.

QuickBooks displays a checkmark in the checkbox.

3 In the Pay to the Order of field, type Cal Telephone.
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4 Press Tab to move to the Amount field.

QuickBooks has an AutoRecall feature that pre-fills new transactions based on 
previous transactions. You can have QuickBooks pre-fill the expense account for a 
vendor transaction based on previous transactions for that vendor. You can change 
this preference to have QuickBooks fill in the amount as well as other information 
from the last transaction with a payee. This is convenient when you have recurring 
payments of the same amount. To change this preference, choose Preferences from 
the Edit menu. Click General, and then select “Automatically recall last transaction 
for this name” on the My Preferences tab.

5 Type 156.91 (the amount of the telephone bill), and then press Tab.

Notice that QuickBooks spells out the amount of the check for you on the line 
below the payee.

6 Click in the Account column on the Expenses tab, and then choose 
Utilities:Telephone from the drop-down list.

Your screen should resemble the following figure.

The Expenses tab is where you assign the amount of the check to one of the expense 
accounts on your company’s chart of accounts. In this case, Rock Castle 
Construction assigns the check to its Utilities account and the Telephone 
subaccount. You use the Items tab only when purchasing items you plan to stock in 
inventory. 

If you select the “Pre-fill accounts for vendor based on past transactions” preference, 
QuickBooks remembers all your recent transactions for a vendor, not just the most 
recent one. If you consistently use the same account for a vendor, QuickBooks will 
automatically pre-fill that information any time you select the vendor in a bill, 
check, or credit card transaction.
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7 Click Save & Close.

8 From the Banking menu, choose Use Register.

Rock Castle Construction has more than one type of bank account, so QuickBooks 
displays the Use Register window and asks you to specify the account you want.

9 Click OK to accept Checking as the account whose register you want to see.

QuickBooks opens the Checking register.

Notice that the check you just wrote is listed in the register as a check that needs to 
be printed.

10 Close the Checking account register.

Refer to Handout 3, “Registers associated with QuickBooks windows”
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 T
ip Do NOT use the Write Checks window if you are paying sales tax, paying payroll taxes 

and liabilities, or paying bills that you have entered previously (that is, you are using A/P 
to track them). Instead, use the Pay Sales Tax window for a sales tax payment, the Pay 
Liabilities window for payroll taxes, and the Enter Bills and Pay Bills windows for paying 
A/P bills.
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Using bank account registers
When you work in QuickBooks, you often use forms—such as a check or an invoice—to 
enter information. But behind the scenes, QuickBooks records your entries in the 
appropriate account register. Each balance sheet account listed on the chart of accounts 
has a register associated with it (except the Retained Earnings account).

Opening a register

When you have a QuickBooks form displayed on your screen, you can view its account 
register by choosing Use Register from the Banking menu, or by double-clicking the 
account name in the chart of accounts.

To open a register (when no form is open):
1 From the Lists menu, choose Chart of Accounts.

QuickBooks displays the Chart of Accounts window.
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2 In the chart of accounts, double-click the Savings account.

QuickBooks opens the register for Rock Castle Construction’s Savings account.

To complete the exercise:
1 Close the Savings register window.

2 Close the chart of accounts.
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Common features of QuickBooks registers

All QuickBooks registers work the same way, regardless of the accounts with which they 
are associated. Here are some common features of all QuickBooks registers:

 The register shows every transaction that affects an account’s balance and lists them 
in chronological order (though you can change the order by choosing a different 
option from the Sort by drop-down list). For example, in a checking account, the 
register shows checks you’ve written (either with QuickBooks or by hand), deposits 
to the account, and withdrawals from the account.

 The columns in the register give specific information about the transaction. The 
first column is the date. The second column shows a reference number (a check 
number or a vendor’s P.O. number) and a type (to tell you whether the transaction 
represents a check or a bill payment, for example). The next column lists the payee, 
the account to which you’ve assigned the transaction, and any descriptive memo 
you choose to type. The final columns for a bank account show the 
transaction amount (either in the Payment or Deposit column) and whether the 
transaction has cleared the bank (indicated by a checkmark in the column).

 On every transaction line, QuickBooks shows the account’s running balance. The 
bottom of the register window shows the account’s ending balance—the balance 
takes into account all the transactions entered in the register, including checks you 
haven’t yet printed.

Entering a handwritten check
Sometimes you need to write a check on the spot for items you did not plan to purchase. 
QuickBooks lets you write the check, and then enter it later in the checking account 
register or on the check form.

Suppose that while picking up supplies one day, you stop at Bayshore Office Supply and 
find a new office chair on sale for $99.95. The sale ends today, so you write a check on 
the spot. You’ll have to enter it in QuickBooks later.
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 T
ip You can edit transactions in registers with some restrictions: You cannot edit a sales tax 

payment. You can edit split amounts for checks (CHK), deposits (DEP), credit card 
charges (CC), credit card credits (CC CRED), bills (BILL), and vendor credits (BILLCRED) 
if all the amounts are assigned to expense (or other) accounts. (If any amount is assigned 
to an item, you must select the transaction and click Splits to edit the split amounts.)

For all other kinds of transactions, only certain fields can be edited directly in the 
register. To edit one of the transactions without restrictions, select the transaction and 
click Edit Transaction to display the transaction in its complete form.
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To enter a handwritten check in the checking account register:
1 From the Banking menu, choose Use Register.

QuickBooks displays the Use Register window.

2 Click OK to accept Checking.

QuickBooks displays the register for the Checking account.

3 Click in the Number field in the blank transaction at the bottom of the register, then 
double-click to highlight the number that QuickBooks prefills.

4 Type 1204, and then press Tab.

5 In the Payee field, type Bayshore Office Supply, and then press Tab.

QuickBooks displays a message telling you that Bayshore Office Supply is not on the 
Name list.

6 Click Quick Add.

QuickBooks displays the Select Name Type window.

Bayshore Office Supply is a vendor, so you can accept the displayed choice.

7 Click OK.

QuickBooks adds the new vendor to the Vendor list.

8 In the Payment field, type 99.95, and then press Tab.

9 In the Account field, type Of, and then press Tab.

QuickBooks fills in Office Supplies.
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10 In the Memo field, type Office Chair.

The Checking account register on your screen should resemble the following figure.

11 Click Record.

12 Close the Checking account register.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the handwritten check to Bayshore Office Supply. 

Account Title Debit Credit

Checking $99.95

Office Supplies $99.95
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Transferring money between accounts
You can easily transfer money to different accounts using the QuickBooks Transfer 
Funds Between Accounts window. Rock Castle Construction wants to record a transfer 
of $5,000.00 from checking to savings made earlier in the day.

To transfer money:
1 From the Banking menu, choose Transfer Funds.

QuickBooks displays the Transfer Funds Between Accounts window.

Notice that QuickBooks displays the current balance for the Savings account.

2 In the Transfer Funds From field, choose Checking from the drop-down list.

3 In the Transfer Funds To field, choose Savings from the drop-down list.
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4 In the Transfer Amount field, type 5000.

Your screen should resemble the following figure.

5 Click Save & Close.

6 Click OK at the message because the money has already been transferred in person.

QuickBooks decreases the balance in the checking account by $5,000 and increases the 
balance in the savings account by $5,000.

When you record the transaction, QuickBooks creates a journal entry. The following 
table shows the journal entry for the funds transfer. 

Account Title Debit Credit

Checking $5,000.00

Savings $5,000.00



                                                                                                

117

L E S S O N  4

Reconciling checking accounts
Reconciling is the process of making sure that your checking account record matches 
the bank’s record.

An overview of reconciliation

When you keep your records with QuickBooks, you don’t have to worry about addition 
or subtraction errors like you do when you’re using a paper check register. Even so, it is 
important to get in the habit of reconciling your QuickBooks bank accounts on a 
monthly basis. This helps you avoid overdraft charges for bad checks, gives you a chance 
to spot possible bank errors, and helps you keep more accurate financial records.

Your bank sends you a statement for each of your accounts each month. The statement 
shows all the activity in your account since the previous statement:

 The opening balance for your bank account (amount in your account as of the 
previous statement)

 The ending balance for your bank account (amount in your account as of the 
closing date for the statement)

 The amount of interest, if any, you’ve received for this statement period

 Any service charges assessed by the bank for this statement period

 Checks that have cleared the bank

 Deposits you’ve made to the account

 Any other transactions that affect the balance of your account (for example, 
automatic payments or deposits or ATM withdrawals or deposits)

When you receive a statement from your bank or from a credit card company, you need 
to reconcile the statement with your QuickBooks records. You can reconcile any 
QuickBooks bank account, including accounts for savings and money market funds. 
The goal of reconciling is to make sure that your QuickBooks records and the bank’s 
statement agree about your account balance.
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Marking cleared transactions

To begin reconciling an account, you need to tell QuickBooks which account you want 
to reconcile. Then you can provide information from the top part of your bank 
statement.

To reconcile your account:
1 From the Banking menu, choose Reconcile.

QuickBooks displays the Begin Reconciliation window.

2 In the Account field, make sure Checking is selected.

3 In the Statement Date field, type 12/15/2007.

4 In the Ending Balance field, type 34592.98.

5 In the Service Charge field, type 14.00.

6 In the Service Charge Date field, type 12/15/2007.

Your screen should resemble the following.
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7 Click Continue.

QuickBooks displays the Reconcile - Checking window.

You can select which columns you want to display by clicking Columns to Display.

8 Select Mark All.

QuickBooks places a checkmark to the left of all items.

If you need to make a correction to a transaction before you reconcile the account, 
highlight the transaction, and click Go To. QuickBooks takes you to the transaction 
and allows you to return to the reconciliation without losing your work.

9 In the Checks and Payments section, click to clear the checkmarks for all items with 
dates later than 12/12/2007.
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10 Repeat the process in the Deposits and Other Credits section—click to clear the 
checkmarks for all items with dates later than 12/12/2007.

Your screen should resemble the following figure.

11 Click Reconcile Now.

QuickBooks displays the Select Reconciliation Report window.

Note: If you see the Reconcile Adjustment window instead, click Return to 
Reconcile and make sure that you have cleared all the checkmarks for all 
items with dates later than 12/12/07. Use the scroll bars to see all the 
items.

12 In the Select Reconciliation Report window, make sure “Both” is selected, and then 
click Display.

13 Click OK at the message that QuickBooks displays.

QuickBooks displays both the reconciliation summary and reconciliation detail 
reports. It’s a good idea to save each reconciliation report, but for the purposes of 
this lesson viewing the reports is sufficient.

14 Examine the reports to learn what they show and the close the report windows.
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Note: QuickBooks Pro overwrites the previous reconciliation report with data from 
the latest reconciliation. If you are using QuickBooks Pro, you may want to print 
a copy of the report, print the report to a file, or save the report in PDF format in 
case you need to reference it again. (To save a report in PDF format, with the 
report displayed, choose Save as PDF from the File menu.) 

If you are using QuickBooks Premier, you can print the reconciliation reports for 
all previous reconciliations.

In addition to the summary and detail reports (which you can view as PDF files), there 
is an additional report option: the Reconcile Discrepancy report. The Reconcile 
Discrepancy report shows changes and deletions made to previously reconciled 
transactions, making it easier to find discrepancies. This report is useful when the 
beginning balance that QuickBooks shows is different than the ending balance from 
the bank statement for the previous period. (To generate the report, choose Reconcile 
from the Banking menu, click Locate Discrepancies, and then click Discrepancy 
Report.)

If the last reconciliation was in error, by clicking Undo Last Reconciliation in the Locate 
Discrepancies window, you can undo it without having to identify and manually clear 
each affected transaction.
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Viewing cleared checks in the register

Now you know that the balance in your QuickBooks check register is accurate as of the 
latest bank statement. The next time you look at the check register, you’ll see a 
checkmark in the Cleared column next to each reconciled transaction.

Open the Checking account register to see the cleared checks.

To viewed cleared checks in the register:
1 From the Banking menu, choose Use Register.

QuickBooks displays the Use Register window.

2 Click OK to accept Checking.

3 Scroll through the register to view the cleared items.

Your register should resemble the figure below.

Notice that QuickBooks displays a checkmark next to all cleared items.

4 Close the Checking account register.
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Locating specific transactions

You can use the QuickBooks Find command to search for specific checks you’ve written. 
For example, suppose you want to find all checks greater than or equal to $500.00 that 
you’ve written during the current year.

To use the Find feature:
1 From the Edit menu, choose Find and then select the Advanced tab.

2 From the Choose Filter list, select Transaction Type.

3 Select Check from the list of transaction types.

4 From the Choose Filter list, select Date, and then choose “This Calendar Year-to-
date.”

5 From the Choose Filter list, select Amount, and then click >= (greater than or equal 
to).

6 Enter 500.00 and click Find.

Your window should resemble the figure below.

7 Close the Find window.
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